Ingo Hilgefort

Reporting and Analysis with SAP® BusinessObjects™

Galileo Press
Bonn • Boston
## Contents at a Glance

1. **Introduction to the SAP BusinessObjects Reporting and Analysis Tools** ................................................................. 19
2. **Customer Requirements and Usage Scenarios** ......................... 31
3. **The Role of the Semantic Layer** ................................................. 49
4. **Enterprise Reporting with SAP Crystal Reports for Enterprise** ............................................................................. 57
5. **Interactive Analysis with SAP BusinessObjects Web Intelligence** .................................................................................. 119
6. **Dashboarding and Data Visualization with SAP BusinessObjects Dashboards** ................................................................. 181
7. **Using SAP BusinessObjects Analysis, Edition for Microsoft Office** ................................................................................. 251
9. **Data Exploration and Searching with SAP BusinessObjects Explorer** ................................................................. 339
10. **Using SAP BusinessObjects Live Office** ................................. 385
11. **Using SAP BusinessObjects BI Workspaces** .......................... 421
12. **Navigating the BI Launch Pad** ................................................... 449
13. **Best Practices and Tips and Tricks for SAP BusinessObjects BI Tools** ................................................................. 469
14. **Integration Outlook** ................................................................. 491
Contents

Introduction ..................................................................................................... 13

1 Introduction to the SAP BusinessObjects Reporting and Analysis Tools ................................. 19
  1.1 Overview of the SAP BusinessObjects Tools ................................................. 19
    1.1.1 Reporting—SAP Crystal Reports .............................................................. 20
    1.1.2 Dashboards and Visualization—SAP BusinessObjects Dashboards .............. 22
    1.1.3 Interactive Analysis—SAP BusinessObjects Web Intelligence ................... 24
    1.1.4 Analysis—SAP BusinessObjects Analysis ................................................ 26
    1.1.5 Data Exploration—SAP BusinessObjects Explorer ................................. 27
  1.2 Other Capabilities of the SAP BusinessObjects Tools ........................................ 28
    1.2.1 SAP BusinessObjects BI and Microsoft Office ....................................... 28
    1.2.2 SAP BusinessObjects BI and Mobility .................................................... 30
  1.3 Summary ................................................................................................. 30

2 Customer Requirements and Usage Scenarios ...................................... 31
  2.1 General Guidelines for Establishing Business Requirements ...................... 31
  2.2 Matching Business Requirements to BI Products ..................................... 33
    2.2.1 Financial Reporting and Analysis Requirements .................................... 33
    2.2.2 Sales Reporting and Analysis Requirements .......................................... 35
    2.2.3 Human Resources (HR) Reporting and Analysis Requirements ............ 36
    2.2.4 C-Level Management and Leadership Reporting and Analysis Requirements .................................................. 36
  2.3 Mapping SAP BusinessObjects BI Tools to Capabilities ............................ 37
  2.4 Mapping SAP BusinessObjects Tools to the Audience ............................. 42
  2.5 Summary ................................................................................................. 48

3 The Role of the Semantic Layer ................................................................. 49
  3.1 Semantic Layer Technology ....................................................................... 49
  3.2 Data Connectivity Options for SAP Systems ............................................. 53
## Contents

3.3 Recommendations for Semantic Layer Usage ........................................ 55
3.4 Summary ........................................................................................ 56

### 4 Enterprise Reporting with SAP Crystal Reports for Enterprise ........................................ 57

4.1 SAP Data Connectivity ........................................................................ 57
4.2 Assessing the Business Requirements ................................................ 62
  4.2.1 Financial Reporting and Analysis Requirements ...................... 63
  4.2.2 Sales Reporting and Analysis Requirements .......................... 63
  4.2.3 Human Resources (HR) Reporting and Analysis Requirements .................. 64
  4.2.4 C-Level Management and Leadership Reporting and Analysis Requirements ........................................ 65
4.3 Introduction to the Tool ........................................................................ 65
  4.3.1 SAP Crystal Reports for Enterprise Designer Environment .... 66
  4.3.2 Data Explorer ........................................................................ 69
  4.3.3 Establishing a Connection to SAP NetWeaver BW .................. 70
  4.3.4 Groupings ............................................................................ 78
  4.3.5 Section Expert ....................................................................... 80
  4.3.6 Conditional Formatting ...................................................... 81
  4.3.7 Saving to SAP BusinessObjects ........................................... 86
4.4 Building a Report for Financial Analysis ................................................. 87
4.5 Building a Report for HR Analysis ............................................................. 101
4.6 Summary ........................................................................................ 118

### 5 Interactive Analysis with SAP BusinessObjects Web Intelligence ............................................ 119

5.1 SAP Data Connectivity ........................................................................ 119
5.2 Assessing the Business Requirements ................................................ 124
  5.2.1 Financial Reporting and Analysis Requirements ...................... 124
  5.2.2 Sales Reporting and Analysis Requirements .......................... 126
  5.2.3 Human Resource (HR) Reporting and Analysis Requirements .................. 126
  5.2.4 C-Level Management and Leadership Reporting and Analysis Requirements ........................................ 127
5.3 Introduction to the Tool ........................................................................ 128
  5.3.1 Creating Your First Report .................................................. 128
Contents

5.3.2 Using Filters ................................................................. 141
5.3.3 Arranging Objects .......................................................... 147
5.3.4 Using Breaks, Sections, and Summaries ......................... 151
5.4 Building a Report for Sales Analysis ...................................... 154
5.5 Building a Report for Financial Analysis .............................. 170
5.6 Summary ................................................................................. 179

6 Dashboarding and Data Visualization with SAP BusinessObjects Dashboards ........................................ 181

6.1 SAP Data Connectivity ......................................................... 181
6.2 Assessment of Business Requirements .................................... 189
  6.2.1 Financial Reporting and Analysis Requirements ............... 189
  6.2.2 Sales Reporting and Analysis Requirements .................. 190
  6.2.3 Human Resources (HR) Reporting and Analysis Requirements .................................................. 192
  6.2.4 C-Level Management and Leadership Reporting and Analysis Requirements ......................... 192
6.3 Introduction to the Tool ....................................................... 193
  6.3.1 SAP BusinessObjects Dashboards Designer Overview .... 193
  6.3.2 Setting Up Your Environment ........................................ 195
  6.3.3 Role of Microsoft Excel ................................................. 198
  6.3.4 Common Look and Feel ................................................. 199
  6.3.5 Creating Your First Dashboard ....................................... 200
6.4 Building a Dashboard for Sales Planning ............................... 224
6.5 Summary ................................................................................. 250

7 Using SAP BusinessObjects Analysis, Edition for Microsoft Office ......................................................... 251

7.1 SAP Data Connectivity ......................................................... 251
7.2 Assessing the Business Requirements ................................. 256
  7.2.1 Financial Reporting and Analysis Requirements ............... 256
  7.2.2 Sales Reporting and Analysis Requirements .................. 257
  7.2.3 Human Resources (HR) Reporting and Analysis Requirements .................................................. 258
  7.2.4 C-Level Management and Leadership Reporting and Analysis Requirements ......................... 258
7.3 Introduction to the Tool ....................................................... 259
## Contents

7.4 Building a Workbook for Financial Analysis ............................................. 272
7.5 Building a Workbook for Sales Analysis .................................................. 284
7.6 Summary ............................................................................................... 295

8 Using SAP BusinessObjects Analysis, Edition for OLAP ......................... 297
8.1 SAP Data Connectivity ........................................................................ 297
8.2 Assessing the Business Requirements .................................................... 302
  8.2.1 Financial Reporting and Analysis Requirements ............................. 302
  8.2.2 Sales Reporting and Analysis Requirements ................................. 303
  8.2.3 Human Resources (HR) Reporting and Analysis Requirements ........ 304
  8.2.4 C-Level Management and Leadership Reporting and Analysis Requirements ............................................. 304
8.3 Introduction to the Tool ......................................................................... 305
8.4 Building a Workbook for Financial Analysis .......................................... 317
8.5 Building a Workbook for Sales Analysis ................................................ 327
8.6 Summary ............................................................................................... 338

9 Data Exploration and Searching with SAP BusinessObjects Explorer .......... 339
9.1 SAP Data Connectivity for SAP BusinessObjects Explorer ..................... 339
9.2 Assessing the Business Requirements .................................................... 344
  9.2.1 Financial Reporting and Analysis Requirements ............................. 344
  9.2.2 Sales Reporting and Analysis Requirements ................................. 345
  9.2.3 Human Resource (HR) Reporting and Analysis Requirements ........ 346
  9.2.4 C-Level Management and Leadership Reporting and Analysis Requirements ............................................. 346
9.3 Introduction to the Tool ......................................................................... 347
9.4 Creating an Information Space for Sales Analysis .................................... 368
9.5 Summary ............................................................................................... 383

10 Using SAP BusinessObjects Live Office ................................................. 385
10.1 SAP BusinessObjects Live Office Configuration .................................... 385
10.2 SAP BusinessObjects BI Platform Content and Microsoft Office .......... 387
10.3 Introduction to the Tool ................................................................. 388
  10.3.1 SAP BusinessObjects Live Office Environment ................. 388
  10.3.2 Using SAP BusinessObjects Live Office and
          Microsoft Excel .................................................................. 391
  10.3.3 Using SAP BusinessObjects Live Office and
          Microsoft PowerPoint ........................................................ 404
  10.3.4 Using SAP BusinessObjects Live Office and
          Microsoft Outlook ............................................................. 404
  10.3.5 Using SAP BusinessObjects Live Office and
          SAP BusinessObjects Explorer ............................................ 410

10.4 Summary ........................................................................................ 419

11 Using SAP BusinessObjects BI Workspaces .............................. 421
  11.1 Overview ........................................................................................ 421
  11.2 Creating Content for Your First SAP BusinessObjects BI
          Workspace ..................................................................................... 427
  11.3 Creating Your First BI Workspace ................................................... 440
  11.4 Summary ........................................................................................ 447

12 Navigating the BI Launch Pad .......... ......................................... 449
  12.1 User Authentication ........................................................................ 449
  12.2 User Interface (UI) Overview ........................................................... 452
  12.3 Folders and Categories ................................................................... 455
  12.4 Using Search in the BI Launch Pad .................................................. 456
  12.5 Configuring User Preferences .......................................................... 462
  12.6 Summary ........................................................................................ 467

13 Best Practices and Tips and Tricks for
SAP BusinessObjects BI Tools .......................................................... 469
  13.1 Selection of the Right Tool ............................................................. 469
  13.2 SAP NetWeaver BEx Query Design ................................................. 470
    13.2.1 Relationship: BEx Query and Report ........................................ 470
    13.2.2 Elements of an SAP NetWeaver BEx Query ........................ 471
    13.2.3 Using Variables in a BEx Query ............................................ 473
    13.2.4 Display Relevant Settings ................................................... 473
  13.3 Data Connectivity ........................................................................... 475
Contents

13.4 User Security ................................................................. 478
13.5 Performance Considerations ........................................... 479
13.6 Known Limitations ......................................................... 481
13.7 Report Design Topics .................................................... 488
13.8 Tracing and Troubleshooting ........................................... 488
13.9 Summary ................................................................. 489

14 Integration Outlook ......................................................... 491

14.1 SAP Crystal Reports for Enterprise ................................ 491
14.2 SAP BusinessObjects Dashboards ............................... 492
14.3 SAP BusinessObjects Web Intelligence ......................... 492
14.4 SAP BusinessObjects Analysis Suite ......................... 492
14.5 SAP BusinessObjects Explorer ................................. 492
14.6 Semantic Layer .......................................................... 493
14.7 Summary ................................................................. 493

The Author ............................................................................. 495
Index ................................................................................ 497
SAP BusinessObjects Analysis, edition for OLAP is your analytical BI client deployment option for the web. In this chapter, you will learn how SAP BusinessObjects Analysis, edition for OLAP is able to fulfill some of your business requirements and provide your users with a rich multidimensional user experience.

8 Using SAP BusinessObjects Analysis, Edition for OLAP

In this chapter we focus on SAP BusinessObjects Analysis, edition for OLAP. We begin by explaining data connectivity options, and then we describe the first steps for using the product to fulfill business requirements.

8.1 SAP Data Connectivity

In this section, you will learn about the different options you can use in combination with SAP BusinessObjects Analysis, edition for OLAP to connect to your SAP data sources. SAP BusinessObjects Analysis, edition for OLAP is part of your SAP BusinessObjects BI platform and uses the shared connections from the platform (see Figure 8.1).

SAP BusinessObjects Analysis, edition for OLAP is able:

- To directly access shared connections from the SAP BusinessObjects BI platform via BI Consumer Services (BICS).
- To connect to BEx queries and InfoProviders in SAP NetWeaver BW, as well as BEx queries combined with the transient provider.
- To establish a direct link to SAP HANA.
As you will notice, SAP BusinessObjects Analysis, edition for OLAP—like SAP BusinessObjects Analysis, edition for Microsoft Office—does not yet integrate with the semantic layer from SAP BusinessObjects. Therefore, the only option for using SAP BusinessObjects Analysis, edition for OLAP in combination with your SAP ERP data is either to use the transient provider as part of the local BI client, or to use SAP HANA. With the latter option, you can replicate the data from your SAP ERP system to SAP HANA and then establish a connection from SAP BusinessObjects Analysis, edition for OLAP to SAP HANA.

Table 8.1 shows the elements supported when using SAP BusinessObjects Analysis, edition for OLAP in combination with a BEx query.

<table>
<thead>
<tr>
<th>Characteristic Values</th>
<th>Direct Access using BICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct access to InfoCube and MultiProvider</td>
<td>Yes</td>
</tr>
<tr>
<td>Access to BEx queries</td>
<td>Yes</td>
</tr>
<tr>
<td>Key</td>
<td>Yes</td>
</tr>
<tr>
<td>Short description</td>
<td>Yes</td>
</tr>
<tr>
<td>Medium and long description</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 8.1 Supported and Unsupported BEx Query Features for SAP BusinessObjects Analysis, Edition for OLAP
<table>
<thead>
<tr>
<th>BEx Query Features</th>
<th>Direct Access using BICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support for hierarchies</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for free characteristics</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for calculated and restricted key figures</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for currencies and units</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for custom structures</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for formulas and selections</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for filter</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for display and navigational attributes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for conditions in rows</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for conditions in columns</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for conditions for fixed characteristics</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for exceptions</td>
<td>Yes</td>
</tr>
<tr>
<td>Compounded characteristics</td>
<td>Yes</td>
</tr>
<tr>
<td>Constant selection</td>
<td>Yes</td>
</tr>
<tr>
<td>Default values in BEx query</td>
<td>Yes</td>
</tr>
<tr>
<td>Number scaling factor</td>
<td>Yes</td>
</tr>
<tr>
<td>Number of decimals</td>
<td>Yes</td>
</tr>
<tr>
<td>Calculate rows as (local calculation)</td>
<td>Yes</td>
</tr>
<tr>
<td>Sorting</td>
<td>Yes</td>
</tr>
<tr>
<td>Hide/unhide</td>
<td>Yes</td>
</tr>
<tr>
<td>Display as hierarchy</td>
<td>Yes</td>
</tr>
<tr>
<td>Reverse sign</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for reading master data</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 8.1 Supported and Unsupported BEx Query Features for SAP BusinessObjects Analysis, Edition for OLAP (Cont.)
Using SAP BusinessObjects Analysis, Edition for OLAP

<table>
<thead>
<tr>
<th>Data Types</th>
<th>Direct Access using BICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support for CHAR (characteristics)</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for NUMC (characteristics)</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for DATS (characteristics)</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for TIMS (characteristics)</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for numeric key figures such as Amount and Quantity</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for Date (key figure)</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for Time (key figure)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SAP Variables—Processing Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>User input</td>
<td>Yes</td>
</tr>
<tr>
<td>Authorization</td>
<td>Yes</td>
</tr>
<tr>
<td>Replacement path</td>
<td>Yes</td>
</tr>
<tr>
<td>SAP exit/custom exit</td>
<td>Yes</td>
</tr>
<tr>
<td>Precalculated value set</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General Features for Variables</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Support for optional and mandatory variables</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for key date dependencies</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for default values</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for personalized values</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SAP Variables—Variable Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Single value</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-single value</td>
<td>Yes</td>
</tr>
<tr>
<td>Interval value</td>
<td>Yes</td>
</tr>
<tr>
<td>Selection option</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 8.1 Supported and Unsupported BEx Query Features for SAP BusinessObjects Analysis, Edition for OLAP (Cont.)
Table 8.2 shows how the direct access BICS option uses the elements from the BEx query, and how the objects are used in SAP BusinessObjects Analysis, edition for OLAP.

<table>
<thead>
<tr>
<th>BEx Query Element</th>
<th>SAP BusinessObjects Analysis, Edition for OLAP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristic</td>
<td>For each characteristic you receive a field and with the context menu you can decide which part of the characteristic you would like to show.</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Each available hierarchy is shown as an external hierarchy and can be used as part of the cross tab. In addition, you can use hierarchy levels as part of your cross tab; for example, you can show all members of Level 2 of the hierarchy.</td>
</tr>
<tr>
<td>Key figure</td>
<td>Each key figure is shown with the unit and scaling factor information.</td>
</tr>
<tr>
<td>Calculated/restricted key figure</td>
<td>Each calculated and restricted key figure is treated like a key figure. The user does not have access to the underlying definition in SAP BusinessObjects Analysis, edition for OLAP.</td>
</tr>
<tr>
<td>Filters</td>
<td>Filters are applied to the underlying query but are not visible in the navigation panel as part of the background filter area.</td>
</tr>
</tbody>
</table>

**Table 8.1** Supported and Unsupported BEx Query Features for SAP BusinessObjects Analysis, Edition for OLAP (Cont.)

<table>
<thead>
<tr>
<th>BEx Query Element</th>
<th>Direct Access using BICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchy variable</td>
<td>Yes</td>
</tr>
<tr>
<td>Hierarchy node variable</td>
<td>Yes</td>
</tr>
<tr>
<td>Hierarchy version variable</td>
<td>Yes</td>
</tr>
<tr>
<td>Text variable</td>
<td>Yes</td>
</tr>
<tr>
<td>EXIT variable</td>
<td>Yes</td>
</tr>
<tr>
<td>Single key date variable</td>
<td>Yes</td>
</tr>
<tr>
<td>Multiple key dates</td>
<td>Yes</td>
</tr>
<tr>
<td>Formula variable</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Table 8.2** SAP NetWeaver BW Metadata Mapping for SAP BusinessObjects Analysis, Edition for OLAP
So far we have reviewed the different data connectivity options available with SAP BusinessObjects Analysis, edition for OLAP. As the next step, we map the product capabilities against our business requirements, so that we can evaluate which of our requirements can be fulfilled.

### 8.2 Assessing the Business Requirements

In this section, we use our list of requirements and compare them with product capabilities. Knowing that SAP BusinessObjects Analysis, edition for Microsoft Office and SAP BusinessObjects Analysis, edition for OLAP are very similar in terms of functional capabilities, it should not come as a surprise that SAP BusinessObjects Analysis, edition for OLAP fulfills similar requirements as SAP BusinessObjects Analysis, edition for Microsoft Office.

#### 8.2.1 Financial Reporting and Analysis Requirements

The only financial requirement that we cannot fulfill using SAP BusinessObjects Analysis, edition for OLAP is the requirement to create very layout-focused and print-oriented reports.
8.2

Assessing the Business Requirements

8.2.2 Sales Reporting and Analysis Requirements

Just as SAP BusinessObjects Analysis, edition for Microsoft Office is able to fulfill most of the requirements in the sales area, SAP BusinessObjects Analysis, edition for OLAP is able to provide similar functionalities (and limitations).

<table>
<thead>
<tr>
<th>Unfulfilled Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶ Content must be available online, offline, and on mobile devices (for sales representatives on the road).</td>
</tr>
<tr>
<td>▶ Distribution of content via email may be required.</td>
</tr>
<tr>
<td>▶ Users should be able to perform scenario-based analysis, where the user is able to see the data but can also influence certain factors and see the impact on the overall numbers; for example, a what-if analysis in a sales planning workflow.</td>
</tr>
</tbody>
</table>
As discussed in Chapter 7, the limitations concern the ability to provide access to the information on a mobile device and the ability to provide offline access to corporate information. Both requests are not possible with SAP BusinessObjects Analysis, edition for OLAP.

At the time of this writing (November 2011) the ability to schedule a SAP BusinessObjects Analysis, edition for Microsoft Office or SAP BusinessObjects Analysis, edition of OLAP document is already part of the product roadmap, but it is not available in the 4.0 FP3 current release.

### 8.2.3 Human Resources (HR) Reporting and Analysis Requirements

The unfulfilled requirements from the HR area shouldn't come as a surprise, as SAP BusinessObjects Analysis, edition for OLAP focuses not on layout-driven reporting but instead on providing strong analytical functionality to your end user.

**Unfulfilled Requirements**

- The content needs to present highly textual information in a layout-focused format.
- Some of the content (such as employee appraisals or performance reviews) will likely be used as official documentation and therefore needs to follow strict layout rules.

These requirements are much better suited for a BI client product like SAP Crystal Reports for Enterprise.

### 8.2.4 C-Level Management and Leadership Reporting and Analysis Requirements

Looking at the requirements from our management and leadership team, we notice that several of the requirements can be fulfilled using SAP BusinessObjects Analysis, edition for OLAP. However, we do have a set of unfulfilled requirements.

**Unfulfilled Requirements**

- The content needs to present highly aggregated information with alerts for important key performance indicators (KPIs).
- The information needs to be available on mobile devices.
Introduction to the Tool

8.3

The consumption of the reports and analytics needs to be simple and easy to use, and critical information needs to be easily identifiable.

Again, in the same way that we are able to provide highly aggregated data using SAP BusinessObjects Analysis, edition for Microsoft Office, we are able to do so using SAP BusinessObjects Analysis, edition for OLAP. However, we lack the capability to create alerts and provide these alerts in a proactive way to our end users. In addition, we are also unable to provide a solution for SAP BusinessObjects Analysis, edition for OLAP on mobile devices.

Based on the audience—our management and leadership team—the requirement to provide critical information in an easy way is not something for which we would use SAP BusinessObjects Analysis, edition for OLAP. In terms of features and functions, the product is more than capable of providing access to critical information, but SAP BusinessObjects Analysis, edition for OLAP is not well suited for this type of audience and the information is better delivered using a different BI client product.

We reviewed all the requirements and decided which of the requirements we can fulfill using SAP BusinessObjects Analysis, edition for OLAP and which are better suited for a different product. In the next section, we describe some basic steps for using the product.

8.3 Introduction to the Tool

Before we use SAP BusinessObjects Analysis, edition for OLAP to fulfill some of our requirements, we will learn the first steps in navigating and analyzing the data from SAP NetWeaver BW. We will leverage the BEx query that we configured for our first steps using SAP BusinessObjects Analysis, edition for Microsoft Office (see Figure 7.2).

As we mentioned in all other previous chapters, BI clients are able to share connections, so there is no need to specifically set up the connection for SAP BusinessObjects Analysis, edition for OLAP. You can find the detailed steps on how to set up the OLAP connections in Chapter 4, Section 4.3.3.
After we configure the OLAP connection in the Central Management Console (CMO) we can build our first workbook using SAP BusinessObjects Analysis, edition for OLAP.

1. Start the BI launch pad by following the menu `Start • Programs • SAP BusinessObjects BI Platform 4 • SAP BusinessObjects BI Platform • SAP BusinessObjects BI Platform • Java BI Launch Pad`.
2. Log on using your SAP credentials.
3. Select the menu `Application • Analysis, edition for OLAP`.
4. You are presented with a list of available connections. Select the connection you created previously.
5. Click on `Next`. You are presented with the list of available BEx queries (see Figure 8.2).
6. Select the BEx query and click on `OK`.

![Figure 8.2 BEx Queries](image)
7. The result set is shown based on the layout configured in the BEx query (see Figure 8.3).

Figure 8.3 Default Resultset

SAP BusinessObjects Analysis, edition for OLAP has three main panels. On the far left, you can see the list of connections and the available metadata, which you can use to analyze the information.

Next to that, you can see the layout panel, which provides you with the option to navigate the data. It also provides you access to the Rows, Columns, and Background Filter areas.

The area on the far right displays the actual data from your report. Each sheet can have up to four components, where a component could be a cross tab or a chart.

1. Select the entry for PRODUCT in the LAYOUT tab.
2. Right-click and select DISPLAY AS (see Figure 8.4).
3. Select the option KEY : TEXT for the product.
4. Select the column header for Net Sales.
5. Navigate to the Display tab.
6. Click on Measure Format (see Figure 8.5).
7. Ensure the Server option is selected for all measures.
8. Click on OK.
9. Right-click on Calendar Year in Rows.
10. Select the Remove menu entry.
11. Right-click on Calendar Year/Month in Rows.
12. Select the Remove menu entry.
13. Right-click on Product in Rows.
14. Select the option Filter • By Measure (see Figure 8.6).
15. Select the option TOP N and enter the value 5.
16. Click on Add.
17. Click on OK.
18. Open the entry for CALENDAR YEAR in the list of available dimensions.
19. Drag and drop CALENDAR YEAR to the BACKGROUND area (see Figure 8.7).
20. Because you moved Calendar Year to the Background area, you are asked to select the actual filter values (see Figure 8.8).
22. Click on OK.
23. Click on AUTO UPDATE (top right corner).
24. Remove PRODUCT from Rows by dragging the object to an empty area (see Figure 8.9).

![Figure 8.9 Remove Product](image)

25. Click on AUTO UPDATE again and your cross tab is updated.

### Auto Update

The AUTO UPDATE option allows you to stop the interactivity with the underlying SAP NetWeaver BW server. You can still navigate in the data but the changes are not reflected in the actual result set until you enable the AUTO UPDATE. In that way, you can minimize the interaction with the SAP NetWeaver BW system.

26. Open the list of available objects for COUNTRY (see Figure 8.10).
27. Drag and drop COUNTRY HIERARCHY 1 to Rows (Figure 8.11).
28. Right-click on COUNTRY HIERARCHY 1 in the layout panel.
29. Select the **Show Levels** menu (see Figure 8.12).

![Figure 8.12 Show Levels](image-url)
30. Select **Leaf Members**.

31. Right-click on **Country Hierarchy 1** in the layout panel and select **Show Levels**.

32. Activate the display of the leaf members.

33. You can also use the available levels and leaf member entries below **Country Hierarchy 1** in the list of available objects (see Figure 8.13). These entries are used for visual filters, meaning that only the display is filtered, not the actual data.

34. Click on the column header for **Transport Costs**.

35. Hold the **Ctrl** button on the keyboard and click on the column header for **Product Costs**.

36. Navigate to the **Analyze** tab.

37. Click on **Calculations**.

38. Select the **Add** option (see Figure 8.14).

**Calculations**

As shown in the previous steps, the calculations in SAP BusinessObjects Analysis, edition for OLAP rely on the order of selecting the elements. The first selected element is used as the first operant and the second selected element is used as the second operant.

39. Click on the column header for **Net Sales**.
Using SAP BusinessObjects Analysis, Edition for OLAP

40. Navigate to the Analyze tab.
41. Click on Calculations.
42. Select the option Dynamic Calculation • Rank Number (see Figure 8.15).

Figure 8.14 Calculations

43. Net Sales is now ranked along the hierarchy.
44. Navigate to the Insert tab.
45. Click on the column chart symbol and select the Clustered Column option (see Figure 8.16).

Figure 8.15 Ranking
46. A column chart is added to the sheet (see Figure 8.17).

47. Select the chart.
48. Select Properties in the far left panel (see Figure 8.18).
49. Activate the option Show Hierarchical Labeling.
50. Click on Apply.
51. Navigate to the Display tab.
52. Click on Swap Axes.
53. Put the chart in full screen mode (see Figure 8.19).
54. Use the small area above the chart to focus on a specific area of your chart in cases where you visualize larger amounts of data.

55. Minimize the chart again so that you can see the table and the chart.

56. Use the SAVE AS menu to store your workbook (see Figure 8.20).

![Figure 8.20 Save As Menu](image)

57. Select a folder for your workbook.

58. Enter a name for your workbook.

59. Click on SAVE.

You can now view your workbook via the BI launch pad.

In this section you learned some basic steps in SAP BusinessObjects Analysis, edition for OLAP. In the next section we discuss which business requirements we can fulfill using SAP BusinessObjects Analysis, edition for OLAP.

### 8.4 Building a Workbook for Financial Analysis

Just as we created a financial report using SAP BusinessObjects Analysis, edition for Microsoft Office, we will use those same queries to create an analytical report using SAP BusinessObjects Analysis, edition for OLAP.

We will use the BEx query, which we already used in combination with SAP BusinessObjectsWeb Intelligence in Section 5.5. As with all other BI client products in the SAP BusinessObjects 4.x suite, SAP BusinessObjects Analysis, edition for OLAP is able to share connections with the other BI client products, so at this stage there is no need to create an additional connection.

1. Start the BI launch pad by following the menu START • PROGRAMS • SAP BUSINESSOBJECTS BI PLATFORM 4 • SAP BUSINESSOBJECTS BI PLATFORM • SAP BUSINESSOBJECTS BI PLATFORM • JAVA BI LAUNCH PAD.
2. Log on using your SAP credentials.
3. Select the menu APPLICATION • ANALYSIS, EDITION FOR OLAP.
4. You are first presented with a list of available connections. Select the connection created previously for the needed BEx query.
5. Click on NEXT.
6. Select the BEx query.
7. Click on OK.
8. Right-click on COST ELEMENT in ROWS.
9. Select REMOVE.
10. Right-click on the hierarchy for COST CENTER in ROWS.
11. Select the menu DISPLAY AS • TEXT.
12. Use the + symbol in the cross tab to open the levels of your hierarchy (see Figure 8.21).

Figure 8.21 Hierarchy Levels in Cross Tab
13. Select the column header of the measure VARIANCE IN %.
14. Right-click and select CONDITIONAL FORMATTING • NEW.
15. Configure two sets of conditional formatting so that values smaller than -50% are highlighted in red and values between 0% and -50% are highlighted in orange (see Figure 8.22).

![Conditional Formatting](image)

**Figure 8.22** Conditional Formatting (Part 1)

16. Activate the PREVIEW option. The PREVIEW option allows you to recognize the impact of the conditional formatting on your cross tab before confirming it.
17. Click on OK (see Figure 8.23).
18. Select the column header for measure VARIANCE IN %.
19. Right-click on the top header of the hierarchy and use the menu FILTER • BY MEASURE (see Figure 8.24).
20. Select the option VARIANCE IN % for BASED ON.
21. Select the LESS THAN option.
22. Enter the value 0.
Using SAP BusinessObjects Analysis, Edition for OLAP

Figure 8.23 Conditional Formatting (Part 2)

Figure 8.24 Context Menu
23. Click on **ADD** (see Figure 8.25).

![Figure 8.25 Filter by Measure](image)

24. Click on **OK**. Your cross tab—including the hierarchical nodes and leaves—are now filtered based on a measure. Based on highlighting and filtering by measure, we are able to quickly identify those areas of our business that have used more of the allocated budget than planned.

25. Move the hierarchy from the **Rows** area to the **Background Filter** area.

26. Add **Cost Element** to **Rows**.

27. Select the column header for **Variance in %**.

28. Right-click on dimension **Cost Element** in the **Rows** area (see Figure 8.26).

29. Select the menu **Filter • by Measure**.

30. Select **Variance in % for Based on**.

31. Select **Bottom N**.

32. Enter the value 10.

33. Click on **ADD**.

34. Click on **OK** (see Figure 8.27).

35. Navigate to the **INSERT** tab.

36. Click on the column chart symbol.
37. Select the option CLUSTERED COLUMN.
38. Right-click on the entry KEY FIGURES in the COLUMNS.
39. Use the menu FILTER • BY MEMBER.
40. Filter your data to show only the VARIANCE and VARIANCE IN % key figures.
41. Click on OK. Your chart will be automatically updated to the change.
So far we have been able to show the bottom 10 cost elements based on those cost centers that have a higher actual cost than the allocated budget. We will now add a second sheet to our analytical report and look for those cost centers that spend the least amount of money.

1. Click on Sheet 2 to navigate to an empty area.
2. Double-click on the INSERT NEW ANALYSIS hyperlink (see Figure 8.28).

3. Remove Cost Element from Rows.
4. Navigate to the INSERT tab.
5. Select the menu INSERT A SUB-ANALYSIS (see Figure 8.29).
6. Navigate to the DISPLAY tab.
7. Select the first cross tab you inserted.
Using SAP BusinessObjects Analysis, Edition for OLAP

8. Click on FOCUSED ANALYSIS.
9. Select the second cross tab you inserted.
10. Navigate to the INSERT tab.
11. Select the menu SWITCH TO • COLUMN • CLUSTERED COLUMN (see Figure 8.30).

Based on the focused navigation, we can now select parts of our cross tab on the top and the measures are shown in the chart for the selected area.
1. Select the column header for **Variance**.

2. Navigate to the **Analyze** tab.

3. Select the menu **Calculations** • **Dynamic Calculation** • **Rank Number**. The variance is now shown as a rank in the cross tab across the shown hierarchy (see Figure 8.31).

4. Open the list of available levels for the shown hierarchy in the data panel (see Figure 8.32).

![Figure 8.31 Dynamic Calculation](image)

![Figure 8.32 List of Available Levels](image)
5. Select the entry **Leaf Members**. By using the **Leaf Member** entry, you can filter the hierarchy by simply dragging and dropping the element onto the cross tab.

6. Drag and drop the entry **Leaf Members** to the hierarchy for **Country** (see Figure 8.33).

7. Select the column header for **Rank Number**.

8. Navigate to the **Analyze** tab.

9. Select the menu **Sort**.

10. Select the **Ascending** option.

Based on the focused navigation being activated, you can select an element in the upper portion, and the lower chart shows only those elements in the chart that have been selected in the upper portion.

We created a sheet that shows those cost elements that have the largest consumption of the actual budget compared to their planned budget. We added a second sheet where, based on a focused navigation and ranking, we are able to quickly select those areas in the hierarchy that so far have used the least amount of the allocated budget. To finish your work, save your workbook as we’ve explained previously.
In this example we used a BEx query from the financial area and were quickly able to analyze the cost centers and cost elements using conditional formatting and filter by measure functionality. We were able to highlight specific cost centers and cost elements based on our needs, and we were able to use a focused navigation to quickly visualize a subset of the data.

**8.5 Building a Workbook for Sales Analysis**

In our second usage scenario for SAP BusinessObjects Analysis, edition for OLAP we are going to create a cost and profitability analysis using the BEx query from Section 7.5. If you followed the steps from the previous chapter, your SAP BusinessObjects BI platform already provides the OLAP connection pointing to the BEx query; otherwise, you can follow the steps outlined in Section 4.3.3 to set up an OLAP connection for this activity.

Assuming you configured the OLAP connection in the CMC, you can now start building your analytical workbook.
Using SAP BusinessObjects Analysis, Edition for OLAP

1. Start the BI launch pad by following the menu START • PROGRAMS • SAP BUSINESS-OBJECTS BI PLATFORM 4 • SAP BUSINESSOBJECTS BI PLATFORM • SAP BUSINESSOBJECTS BI PLATFORM • JAVA BI LAUNCH PAD.

2. Log on using your SAP credentials and SAP authentication.

3. Select the menu APPLICATION • ANALYSIS, EDITION FOR OLAP.

4. You are presented with a list of available connections. Select the connection you created previously for the needed BEx query.

5. Click on NEXT.

6. Select the BEx query for this scenario.

7. Click on OK.

8. You are presented with the view as defined in the BEx query (see Figure 8.35).

9. Select PRODUCT GROUP from the data panel and drag it on top of SALES ORGANIZATION in the layout panel so that it replaces the hierarchy (see Figure 8.36).
10. Add PRODUCT to ROWS.
11. Navigate to the DISPLAY tab.
12. Select the menu TOTALS & PARENTS and disable the option DISPLAY SUB-TOTALS.
13. Select the column header for CUSTOMER DISCOUNT.
14. Press the (Ctrl) button on the keyboard and select the column header for QUANTITY DISCOUNT.
15. Navigate to the ANALYZE tab.
16. Select the menu CALCULATIONS • ADD.
17. Right-click on the column header for the newly created measure.
18. Select the menu CUSTOM CALCULATION • EDIT (Figure 8.37).

Figure 8.36  Exchanging Dimensions

Figure 8.37  Editing Calculation
19. Enter "Total Discount Amount" in the Name field.
20. Click on OK.
21. Select the column header for Total Discount Amount.
22. Drag and drop the column for the measure next to Gross Sales.
23. Navigate to the Analyze tab.
24. Select the menu Calculation • Custom Calculation.
25. Click on Add Member.
27. Click on OK.
28. Enter a `-` after the measure Gross Sales.
29. Click on Add Member.
30. Select Total Costs Amount.
31. Enter "Net Sales" in the Name field.
32. Click on OK.
33. Select the column header for Net Sales.
34. Drag and drop the column for the measure next to Total Discount Amount.
35. Select the menu Calculation • Custom Calculation.
36. Click on Add Member.
37. Select Net Sales.
38. Click on OK.
39. Enter a `-` after Net Sales.
40. Click on Add Member.
41. Select Sales Commission.
42. Click on OK.
43. Enter a `-` after Sales Commission.
44. Click on Add Member.
45. Select Material and Product Costs.
46. Click on OK.
47. Enter a `-` after Material and Product Costs.
48. Click on Add Member.
49. Select **Total Sales Costs**.
50. Click on OK.
51. Enter “Operating Profit” in the **Name** field.
52. Click on OK.
53. Right-click on **Key Figures** in **Columns**.
54. Select the menu **Filter • by Member**.
55. Select **Gross Sales**, **Total Discount Amount**, **Net Sales**, and **Operating Profit** (see Figure 8.38).

![Figure 8.38 Selecting Key Figures](image)

56. Select **Product Group** in the cross tab.
57. Navigate to the **Display** tab.
58. Select the menu **Hierarchy • Compact Display in Rows** (see Figure 8.39).
Using SAP BusinessObjects Analysis, Edition for OLAP

59. Select the menu **Totals & Parents** and enable the option **Display Sub-Totals**. **PRODUCT GROUP** and **PRODUCT** now behave like a hierarchy.

60. Select the menu **Calculation • Custom Calculation**.

61. Click on **Add Member**.

62. Select **Operating Profit**.

63. Click on **OK**.

64. Enter “%_A” after **Operating Profit**.

65. Click on **Add Member**.

66. Select **Net Sales**.

67. Click on **OK**.

68. Enter “Profit in %” in the **Name** field.

---

**Figure 8.39 Compact Display**

![Compact Display](image)

<table>
<thead>
<tr>
<th>Key Figures</th>
<th>Gross Sales</th>
<th>Total Discount Amount</th>
<th>Net Sales</th>
<th>Operating Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Result</td>
<td>$318,668,387.22</td>
<td>$29,793,709.48</td>
<td>$209,872,096.54</td>
<td>$177,514,728.16</td>
</tr>
<tr>
<td>Apple 1%</td>
<td>$7,505,617.61</td>
<td>$745,327.46</td>
<td>$6,760,290.15</td>
<td>$5,145,163.02</td>
</tr>
<tr>
<td>Apple 20% 0.1%</td>
<td>$116,031.44</td>
<td>$33,941.65</td>
<td>$82,090.79</td>
<td>$62,794.52</td>
</tr>
<tr>
<td>Apple 20% 0.5%</td>
<td>$1,094,927.44</td>
<td>$182,948.07</td>
<td>$912,979.37</td>
<td>$730,001.31</td>
</tr>
<tr>
<td>Apple 1% 1.1%</td>
<td>$1,090,016.06</td>
<td>$172,676.96</td>
<td>$917,346.12</td>
<td>$732,264.26</td>
</tr>
<tr>
<td>Apple 2% 2.1%</td>
<td>$2,465,889.67</td>
<td>$396,718.38</td>
<td>$2,069,171.30</td>
<td>$1,623,256.23</td>
</tr>
<tr>
<td>Apple 20%</td>
<td>$2,795,470.22</td>
<td>$523,900.24</td>
<td>$2,271,569.98</td>
<td>$1,824,000.03</td>
</tr>
<tr>
<td>Apple Net</td>
<td>$5,674,697.25</td>
<td>$632,497.25</td>
<td>$6,305,294.50</td>
<td>$5,578,689.95</td>
</tr>
<tr>
<td>Apple Gains</td>
<td>$1,711,475.56</td>
<td>$196,301.17</td>
<td>$1,515,174.39</td>
<td>$1,322,793.09</td>
</tr>
<tr>
<td>Brandy 20%</td>
<td>$50,792,636.71</td>
<td>$4,809,800.56</td>
<td>$45,982,836.15</td>
<td>$37,627,069.18</td>
</tr>
<tr>
<td>Brandy 30%</td>
<td>$30,058,296.74</td>
<td>$3,191,766.15</td>
<td>$26,866,530.59</td>
<td>$22,071,062.49</td>
</tr>
<tr>
<td>Brandy 40%</td>
<td>$60,367,310.95</td>
<td>$5,327,226.43</td>
<td>$54,039,984.52</td>
<td>$43,839,220.09</td>
</tr>
<tr>
<td>Brandy 50%</td>
<td>$44,762,844.67</td>
<td>$4,282,674.33</td>
<td>$40,480,170.34</td>
<td>$32,903,652.64</td>
</tr>
<tr>
<td>Choco-boxes</td>
<td>$18,875,043.63</td>
<td>$1,438,809.68</td>
<td>$17,436,233.95</td>
<td>$15,586,827.75</td>
</tr>
<tr>
<td>Crisp</td>
<td>$12,214,210.96</td>
<td>$1,679,256.94</td>
<td>$10,535,054.02</td>
<td>$9,151,278.03</td>
</tr>
<tr>
<td>Orange 10%</td>
<td>$4,997,761.23</td>
<td>$492,674.10</td>
<td>$4,505,087.13</td>
<td>$3,900,680.85</td>
</tr>
<tr>
<td>Orange 20%</td>
<td>$7,084,512.12</td>
<td>$713,155.02</td>
<td>$6,371,357.10</td>
<td>$5,009,058.19</td>
</tr>
<tr>
<td>Orange 30%</td>
<td>$6,734,452.68</td>
<td>$752,902.79</td>
<td>$6,041,549.89</td>
<td>$4,958,299.85</td>
</tr>
<tr>
<td>Orange Juice</td>
<td>$6,703,930.49</td>
<td>$750,471.97</td>
<td>$5,944,458.52</td>
<td>$4,710,531.18</td>
</tr>
<tr>
<td>Pumpkin</td>
<td>$20,262,411.97</td>
<td>$1,695,104.70</td>
<td>$18,567,307.27</td>
<td>$15,520,274.37</td>
</tr>
<tr>
<td>Softdrinks</td>
<td>$19,995,099.97</td>
<td>$1,756,909.65</td>
<td>$18,238,189.32</td>
<td>$15,349,276.66</td>
</tr>
<tr>
<td>Total</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>
69. Click on OK.
70. Select the newly created measure Profit in %.
71. Navigate to the ANALYZE tab.
72. Select the menu CONDITIONAL FORMATTING • NEW.
73. Set the FORMAT TO SYMBOL.
74. Define a condition using green for values greater than 75.
75. Click on ADD.
76. Define a condition using orange for values between 50 and 75.
77. Click on ADD (see Figure 8.40).

![Conditional Formatting](image)

**Figure 8.40** Conditional Formatting

78. Activate the PREVIEW option.
79. Click on OK (see Figure 8.41).
By using conditional formatting and a set of calculations, we are able to identify our most profitable product groups and products. In the next steps, we look into our sales regions in more details.

1. Navigate to the Outline of your workbook (see Figure 8.42).
2. Select the cross tab from Sheet 1 in the outline.
3. Click on the Copy button.
4. Click on Sheet 2 to navigate to an empty area.
5. Click on the Paste button to create a copy of your existing cross tab on Sheet 2.
6. Click on Auto Update.
7. Remove all dimensions from Rows.
8. Add Sales Region to Rows.
9. Add Group to Rows.
10. Click on Auto Update to refresh your workbook.
Based on the still active conditional highlighting, we can see that the sales regions are all around 75% profit (see Figure 8.43). At this point we decide to look into the products by retail chain.
11. Drag and drop Chain to Rows so that it replaces Sales Region.
12. Drag and drop Product to Rows so that it replaces Group.
13. Right-click on Chain in the Rows of the layout panel.
14. Select the menu Filter • By Measure (see Figure 8.44).

15. Select Gross Sales for Based on.
16. Select the option Top N for Include Members.
17. Enter the value 10.
18. Click on Add.
19. Click on OK.
20. Right-click on Product in the Rows of the layout panel.
21. Select the menu Filter • By Measure (see Figure 8.45).
22. Select Gross Sales for Based on.
23. Select Top N for Include Members.
24. Enter the value 5.
25. Click on Add.
26. Click on OK.

You are shown the top 5 products for the top 10 retail chains. You can quickly see that—based on profit in %—there is a small group of products that is more profitable than others.
27. Remove Chain from Rows.

28. Navigate to the Insert tab.

29. Click on the Pie Chart icon ( ).

30. Navigate to the Display tab.

31. Click on Focused Navigation (see Figure 8.46).

You can now use the option to select a measure in the cross tab in the upper part, and the pie chart will show only the selected measure.

Figure 8.45 Cross Tab with Filter by Measure

Filter by Measure

As you might have noticed, the definition of the filter by measure functionality is different between SAP BusinessObjects Analysis, edition for Microsoft Office and SAP BusinessObjects Analysis, edition for OLAP. In the edition for Microsoft Office, you can set up a filter by measure for the most inner rows or columns, and the filter will be dynamic based on the navigation. In the edition for OLAP, the filter by measure functionality is defined based on the selected dimension and is not dynamic based on the overall navigation.
In this example we used SAP BusinessObjects Analysis, edition for OLAP to analyze the profitability of our products. We identified those products with the best profitability and we were also able to extend our analysis to the sales regions and retail chains. By using conditional formatting and filtering by measure settings, we are able to quickly find the information that we need.

**8.6 Summary**

In this chapter you learned where SAP BusinessObjects Analysis, edition for OLAP can help to fulfill business requirements, as well as the first steps in using the product. You then were able to create two scenarios for your end users. In the next chapter you will learn how to use SAP BusinessObjects Explorer to fulfill some of your requirements.
Index

A

Aggregate, 479
Aggregation, 479
Alerting, 492
Alerts, 44
Analysis, 41, 301, 302, 492
Analytics, 45
Appearance, 248, 249
Application, 355, 376
Attribute
display, 59, 61, 121, 124, 184, 187, 188, 253, 255, 299, 302, 341, 343
navigational, 59, 62, 121, 124, 184, 187, 188, 253, 255, 299, 302, 341
Auditing, 481
Authentication, 72, 73, 90, 355, 376, 429
method, 449
mode, 350
type, 76
authentication.default, 451
authentication.visible, 451
Authorization, 60, 122, 185, 254, 300, 342
BI, 478
variable, 473

B

Behavior, 216, 222, 245, 247, 248, 249
Best practices, 469
BEx Analyzer, 251, 297, 488
BEx query, 52, 61, 120, 123, 183, 186, 187, 252, 255, 298, 299, 301, 340, 341, 343, 476
BI, 19, 26
BI Consumer Services → BICS
BI launch pad, 449, 455
docs, 453
folders and categories, 455
SAF authentication, 450
search, 456
user interface, 452
user preferences, 462
BI Launchpad.properties, 451

BI Web Services, 182
BICS, 52, 58, 120, 186, 187, 251, 255, 301, 343
Break, 151
Business analyst, 46
Business intelligence → BI
Business layer, 353, 370
Business requirement, 31, 33, 35, 36, 37, 42, 46, 63, 64, 65, 189, 256, 258, 344, 345, 346, 469, 470
BW MDX, 482
BW query, 58, 120, 183, 252, 298, 340

C

Calculation, 34, 63, 189, 345
local, 184, 253, 299, 341
Can Grow, 89
Canvas, 194, 195
Category, 194, 455, 456
Central Management Console → CMC
Characteristic, 52, 58, 61, 120, 121, 123, 183, 186, 187, 252, 255, 298, 301, 341, 471, 472, 473
compounded, 59, 121, 184, 253, 299, 341
free, 58, 121, 183, 252, 299, 341, 472
value, 52
Charts, 212
Client, 72
CMC, 71, 457
Common, 246, 247
Component, 194, 211, 248
Condition, 52, 59, 121, 184, 253, 299, 341, 343, 472
Conditional formatting, 52, 81
Connectivity, 251, 297
Constant selection, 59, 121, 184, 253, 299, 341
Content type, 460
Crawling frequency, 459
Crosstab, 88
Currency, 58, 488
Custom exit, 60, 122, 185, 254, 300, 342
Index

D
Dashboard, 200, 492
Dashboard Manager, 421
Dashboarding, 39, 181
Data
   connectivity, 181, 256, 302, 339
   exploration, 339
   foundation, 351, 353, 369, 370
   panel, 138
   retrieval, 480
   source, relational, 353, 370
   type, 59, 122, 184, 253, 300, 342
Database field, 69
Date formatting, 488
Default theme, 195
Default value, 60, 122, 185, 254, 300, 342, 472
Desktop, 131
Destination, 212, 229
Detail object, 137
Dimension, 52
Direct access, 251
Display setting, 473
Distribution, 35, 190, 257, 303
Document Explorer, 425
Document preferences, 195
Drill down, 154, 216, 217, 218, 221, 433, 434
DSO objects, 339
Dynamic visibility, 216, 222

E
Embedded spreadsheet, 198
Enterprise reporting, 20, 57
ERP, 181
Excel options, 196
Exception, 52, 59, 121, 184, 253, 299, 341, 472
Exit, 60, 122, 254, 300
EXIT variable, 473
Exploration, 27
Explorer, 492

F
Field Explorer, 69
Filter, 59, 61, 121, 141, 154, 166, 184, 253, 299, 341, 472, 480, 482
Filter by Measure, 52
Financial reporting, 87
Fixed label size, 246, 247, 248
Fold, 166
Folders, 455
Format, 176
Formatted layout, 37
Formatted value, 488
Formula, 34, 58, 63, 121, 184, 189, 253, 299, 341, 345
   field, 69
   workshop, 85
Formula Editor, 165
Free form layout, 39

G
General, 223, 229, 234, 245, 246, 247
Grid preferences, 195
Group, 78
   footer, 81
Grouping, 78
Guided navigation, 26, 40

H
Hierarchical awareness, 39
Hierarchy, 34, 39, 58, 61, 121, 123, 125, 183, 186, 187, 189, 252, 255, 299, 301, 341, 343, 345, 477, 481, 488
   node variable, 39, 482
   variable, 39, 481
   version variable, 482
Highlighting, 86
Horizontal slider, 248

I
Increment, 248, 249
Index, 479
InfoCube, 58, 120, 183, 252, 298, 340
InfoProvider, 350, 352, 369, 470, 477

transient, 62
Information Design Tool, 51, 52, 101
Information space, 355, 357, 375, 376
InfoSets, 478
InfoView, 128, 157, 172
Input control, 138
Insertion type, 218, 221, 229, 434
Interactive, 131
Interoperability, 39

K

Key date, 60, 122, 179, 185, 254, 300, 342
variable, 482
Key figure, 52, 61, 122, 123, 186, 187, 255,
301, 471, 473
 calculated, 58, 61, 121, 123, 184, 186, 188,
253, 255, 299, 301, 341, 343, 476, 477, 481
 restricted, 58, 61, 121, 123, 184, 186, 188,
253, 255, 299, 301, 341, 476, 477, 481
Key performance indicator (KPI), 36, 37, 45,
65, 127, 258, 304, 347

L

Label, 229
Language, 72
Limitation, 469, 481
Local calculation, 121
logontoken.enabled, 451

M

Manage Spaces, 355, 376
Map, 138
MDXTEST, 489
Measure, 52
Member, 52
Metadata, 476
Metrics, 45
Microsoft Excel, 28, 385, 403, 421
Microsoft Office, 34, 345
Microsoft Outlook, 28
Microsoft PowerPoint, 28, 422
Microsoft Word, 28, 422
Module Library, 422, 441
Multiple structures, 58, 121, 184, 253, 299,
341
MultiProvider, 58, 120, 183, 252, 298, 340,
368
Multisource, 477
Multi-source enabled, 351, 370

N

Number format, 248, 249
Number formatting, 488

O

Object, 357, 376
Object browser, 194, 214, 216, 217, 218, 221
Offline, 35, 190, 257, 303, 346, 478
Offline dashboards, 492
OLAP, 26
 connection, 71, 76, 90, 428
universe, 128

P

Page footer, 67
Page header, 67
Parameter, 100, 482
 field, 69
Parameter mapping, 444
Parameterized layout, 38
Performance, 469, 479
Personalization, 60, 122, 185, 254, 300, 342
Pioneer → SAP BusinessObjects Advanced Analysis
Precalculated value set, 60, 122, 185
Preferences, 129, 195
Preferred viewing locale (PVL), 464, 488
Prompt, 52
Properties, 194
Provider, 72
Publication, 478
Index

Q

Query, 52, 470
  filter, 136
  panel, 403

R

Relational access, 182
Relative position, 165
Replacement path, 60, 122, 185, 254, 300, 342
Report design, 488
Report footer, 67
Report header, 67
Reporting, 41
Requirement, 302, 304
Restriction, 472
Result object, 135, 138, 158, 172
RSRT, 489
RSTT, 489
Run query, 138, 159
Running total field, 69

S

SAP authentication, 129, 157, 172
SAP BusinessObjects, 74, 186, 251
SAP BusinessObjects Advanced Analysis, 26, 42, 64, 65, 256, 473
SAP BusinessObjects Analysis, 251, 255, 256, 257, 297
SAP BusinessObjects Analysis, edition for Microsoft Office, 255, 256, 302
SAP BusinessObjects Analysis, edition for OLAP, 421, 464
SAP BusinessObjects Dashboards, 22, 64, 65, 126, 181, 186, 187, 224, 257, 344, 421, 442, 481, 485
color schemes, 200
data connectivity, 181, 201
embedded spreadsheet, 198
Live office compatibility, 196
templates, 199
themes, 200
SAP BusinessObjects Dashboards SDK, 22
SAP BusinessObjects Explorer, 27, 39, 46, 339, 340, 344, 347, 368
SAP BusinessObjects Live Office, 24, 28, 182, 196, 345, 385, 387, 389, 404, 470
  add/remove fields, 395
  appearance, 390
  authentication, 387
  choose Excel data range, 401
column Heading, 390
conceal data, 402
copy and paste with connectivity, 389
default Cell Values, 390
filter Settings, 395
modify objects, 395
new query, 403
prompt values, 401
prompts, 399
properties, 395
properties for all objects, 402
publish to SAP BusinessObjects, 398
refresh, 389, 399, 402
SAP authentication, 391, 410
SAP BusinessObjects Web Intelligence content, 398
switch to fields, 393, 412
use specific logon criteria, 386
SAP BusinessObjects Live Office Live Office compatibility, 196
query panel, 135, 141
SAP BusinessObjects Web intelligence, 64, 65
SAP Crystal Reports, 20, 24, 42, 57, 64, 101, 124, 127, 190, 192, 344, 387, 391, 411, 421, 456, 469, 473, 479, 482
data connectivity, 57
SAP Crystal Reports 2011, 183
SAP Crystal Reports for Enterprise, 61, 442, 456, 491
SAP ERP, 57, 102
SAP exit, 60, 122, 185, 254, 300, 342
SAP HANA, 27, 251, 252, 297, 298, 339, 340, 344, 487, 492
SAP NetWeaver BW, 57, 182, 340, 343, 351, 355, 370, 375
SAP NetWeaver BW Accelerator, 347
SAP NetWeaver demo model, 202
Save Language, 72
Scaling, 59, 121, 184, 253, 299, 341
Scenarios, 44
Scorecarding, 492
Searching, 339
Section, 151, 166
Section Expert, 80, 83
Security, 469, 478
Security Definition Editor, 478
Selection, 58, 121, 184, 253, 299, 341, 480
Selector, 211
Self-service, 24, 39
Semantic layer, 51, 52, 124, 477, 493
Server, 72
  context, 75
  name, 75
  port number, 75
  type, 72
Show object name, 164
Sizing, 481
Skill level, 469
Source data, 212, 229
SSO, 73, 76, 90, 129, 157, 172, 429
Structure, 34, 58, 62, 121, 124, 184, 187, 188, 253, 256, 299, 302, 341, 345, 472, 476, 477, 482
Summary, 151
System, 72
  display name, 75
  number, 72
T
Tab set, 228, 229
Text variables, 473
Time dependency, 345
Time dependent, 34, 36, 101
Tracing, 488
Tracking, 178
Transient provider, 251
Trend, 379
Troubleshooting, 488
U
Unfold, 166
Unit, 58
Universe, 51, 119, 124, 182, 339, 340, 355, 375, 376, 387, 403, 404, 460, 477
dimensional, 51
multisource, 52
relational, 51, 58, 120, 339, 343
Universe Designer, 51
User
  input, 60, 122, 185, 254, 300, 342
  name, 76
  type, 42, 46
V
Value set
  precalculated, 254, 300, 342
Variable, 52, 60, 62, 122, 124, 185, 187, 188, 254, 256, 300, 302, 342, 343, 473, 477, 482, 484, 485, 486, 488
Variable editor, 159
Visualization, 39, 65, 181, 193
W
Web ActiveX, 467
Web Application Designer, 492
What-if analysis, 35, 64, 126, 257, 303, 346
Workspace, 421, 427, 440, 446
X
Xcelsius → SAP BusinessObjects Dashboards